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Maintenance Windows
The Meridian 1 switch has over 600 overlay-based maintenance commands 
and over 200 types of circuit cards to support its powerful capabilities. To 
maintain a Meridian 1, you must remember (or look up) which overlay has 
the appropriate commands and the syntax of each command—an enorm
task! 

Welcome to MAT Maintenance Windows. The 37 Maintenance Overlays 
grouped into eight hardware-related windows to allow you to perform all
maintenance tasks without having to remember or look up any overlay-ba
commands. The new interface provides a comprehensive view of Meridia
hardware configuration with the following benefits:

• see quickly the equipped hardware. The hardware list works like a sp
sheet data view—you can scroll through the list, sort the list, and se
items for changing.

• select an item from the list and apply a Maintenance command from
right-mouse button popup menu

• print the list or copy it to a spreadsheet

• select a TN or DN and print the TN/DN block

• see Enabled/Disabled status in real time

For example, to disable a network loop, you click on the loop number an
choose the Disable command from the menu. Maintenance Windows load
the appropriate overlay, executes the command, and displays the result 
action in a window that you can scroll and save.

This chapter of the Maintenance Windows User’s Guide describes functions 
that are common to all of the Maintenance window applications. Be sure to 
read this section thoroughly to help you use these applications efficiently. 
MAT Maintenance Windows User Guide
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About this user guide
This user guide is intended to provide you with an introduction to the MAT 
Maintenance Windows application as well as an overview of its major 
functions.

Conventions used in this user guide
This user guide uses the following terms:

• Computer system refers to the hardware and software of an 
IBM-PC™ or 100% compatible PC.

• Windows refers to the Microsoft family of graphical user interface 
(GUI)-based operating systems.

• Mouse refers to any standard PC pointing device. Common mou
actions include point, click, right-click and double-click.

• Standard Windows terminology includes: icon, window, dialog box 
(or dialog) and menu.

• Angle brackets denote a single keyboard key. For example, <Es
denotes the Escape key, labeled Esc on PC keyboards. Angle 
brackets with multiple keys denote keyboard keys to use 
simultaneously. For example, <Ctrl-Alt-Del> denotes the key 
sequence for rebooting a PC.

• This font is used to designate buttons, menu choices and 
information you are to enter.

Help
This user guide does not discuss each Maintenance Windows function a
command in detail. It only discusses the major functions and how they a
accessed. For detailed information on each Maintenance Windows func
use the on-line Help function. You can use the Help function to obtain h
for topics either directly or via its index and word-search functions. While
running Maintenance Windows, you can obtain context-sensitive help on
topic you require by simply clicking Help from a specific dialog or window.

To obtain help for a topic, click Help from the currently selected dialog or 
window. This will access the Windows Help function and display contex
sensitive help information on the current topic.
P0906946 Standard April 2000
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Once you have accessed Help, use it to scroll through the other Maintenance 
Windows help topics, search for a specific topic or print the help information.

To view a list of Help topics for Maintenance Windows, click Contents from 
the Help drop-down menu. Choose from one of the items in this list to load 
the Help file and display its information.

Launching a Maintenance Windows application
You launch Maintenance Windows applications from the MAT System 
window. Figure 1 below shows the MAT System window.

Under Core Equipment, double-click the icon for the desired Maintenance 
Windows application to launch that application. The appropriate window 
appears. Each application is described in detail in a separate chapter in this 
document.

Figure 1
MAT System window 
MAT Maintenance Windows User Guide
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For example, double-click on the Network Loops icon to open the Network 
Loops window (see Figure 2). Each loop is listed, along with descriptive 
information. From this window, you can sort this information, select a loop 
and run maintenance commands, and get help on the selected loop. 

Figure 2
Network Loops window 
P0906946 Standard April 2000
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Maintenance Windows applications
MAT Maintenance Windows includes the following applications:

Core CPU
The CPU window displays the status of cards in both CPU shelves on the 
Meridian 1 at the selected site. You can perform actions and tasks on cards in 
the CPU shelf from the CPU window.

I/O Ports
The I/O (Input/Output) Ports window displays the status of all I/O ports on 
the Meridian 1, and allows you to execute actions and tasks on a selected port.

Network Groups
The Network Groups window displays the status of all Network Group Cards 
on the Meridian 1, and allows you to execute actions and tasks on a selected 
card.

Network Loops
The Network Loops window lists all the network loops on the Meridian 1 
system. It allows you to execute actions and tasks on a selected loop by 
choosing commands from the Maintenance menu.

PE Shelves
The PE Shelves window displays the status of the Peripheral Controller Cards 
for each PE Shelf on the Meridian 1, and allows you to execute actions and 
tasks on a selected card.

PE Cards
The PE Cards window displays the status of all EPE and IPE Peripheral 
Equipment cards for each PE Shelf on the Meridian 1, and allows you to 
execute actions and tasks on a selected card.

PE Units
The PE Units window displays information for all PE units and Directory 
Numbers on the Meridian 1 system, and allows you to execute actions and 
tasks on a selected unit.
MAT Maintenance Windows User Guide
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B- and D-channels
The PRI/PRI2 B and D-channels window displays the B and D-channels on 
the selected digital trunk (for example, PRI loop), and allows you to execute 
actions and tasks on a selected channel.

Option 11C Line Size Expansion
The Option 11C Line Size Expansion increases the Option 11C line capacity 
from the current three expansion cabinet configuration to a maximum of five 
expansion cabinets. Along with this expansion, the Option 11C will support 
an additional 20 IPE cards.

Option 11C Mini
The Option 11C Mini affords full Meridian 1 feature functionality to the 20 
to 80 line PBX customer. The three mounting opitons, wall, rack, and table 
top, are fully MAT and X11 system software compatible. There is an option 
for an expansion cabinet which supports an additional four peripheral slots. 
MAT recognizes this system type as an Option 11C in the Navigator and 
System Properties windows. 

Inventory Reporting
The Inventory Reporting window allows you to generate and download 
inventory files listing cards and sets installed in the Meridian 1. 

Full documentation in on-line help
Each Maintenance Windows application has been designed to be fully 
documented in the on-line help. Each menu command, button, and field is 
documented. Please be sure to consult the on-line help if you wish to get more 
detail about any of these items. 

For help on an object in a list, select the item and use the right mouse button 
to select What’s This  help. Descriptive information on the item appears. For 
example, ask for help on a TTY object and the window shown in Figure 3 
appears. 
P0906946 Standard April 2000
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Performing a maintenance task on an item
To perform a maintenance task on a card, loop, shelf, and so on, follow these 
steps:

1 Open the appropriate Maintenance Windows application.

2 Select the item from the list.

3 Choose a command from the Maintenance menu, the toolbar, or by using 
the right mouse button popup menu. A confirmation dialog appears for 
potentially destructive commands.

4 The script appears in the command result section of the window, followed by 
the overlay output.

Figure 3
“What’s This” help on PTY
MAT Maintenance Windows User Guide
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Meridian 1 connection
Maintenance window applications are connected to the Meridian 1 by a 
Pseudo TTY (PTY). A PTY is a “software only” TTY that uses an I/O por
address. PTYs are displayed in the I/O Ports window.

• One PTY is used for all Maintenance Windows users connected to t
system (even from multiple PCs)

• One PTY is used for each System Terminal connection even if it is n
logged into the overlays

Queueing scripts
If the Meridian 1 is currently processing another user’s script, your comm
is placed in a queue. You must wait until your script is finished processin
before you can choose another Maintenance menu command. However, 
while you are waiting, you can perform maintenance tasks on another typ
system component using a different Maintenance Windows application.

Cancelling scripts
To remove a command from the queue or to cancel a command in prog
click Cancel. Pressing the <Esc> key will also remove or cancel a command
If a command is in progress, Cancel aborts the current command and overla
by sending four stars (****).

Refreshing the hardware status in the list
The hardware status in the list is updated as follows:

• The list is updated every few seconds even if there is no activity on 
MAT PC. You specify the interval on a per-window basis. See the About 
Maintenance Windows item in the Help menu.

• The selected object status is updated at every MAT PC after every sc
Thus, disabling a port from one PC updates its status on all other PC

• The entire list is updated after some scripts because multiple objects
affected. Examples: Split CPU, Disable MSDL 

• You can manually refresh the hardware status display by pressing <F5>.
P0906946 Standard April 2000
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Menu commands
Each menu command is fully documented in on-line help. The Status Bar 
provides useful information on the script to run (see “Using the Status B
on page 23). 

You can also read What’s This  help on any menu command. Press 
<Shift><F1>  (or select What’s This  from the Help  menu) and select the 
command for full on-line documentation.

The Maintenance  menu is unique for each hardware application, and is also 
designed to be fully documented in on-line help. In addition to the 
information provided in the Status Bar, you can read What’s This  help on any 
menu command as described above.

Getting help on an error message
Sometimes, a maintenance command will result in a Meridian 1 error 
message, such as NWS010. To get help on the last error message (even if it 
has scrolled out of view) choose Error Message  from the Help  menu.

To get help on a previously-displayed error message:

• Use the scroll bar to move to the error message. Double-click the er
message.

or

• Select the error and choose Error Message from the Help menu.

or

• Press <Ctrl>E for information on the last error message.
MAT Maintenance Windows User Guide
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Getting around in the maintenance window
You can use the maintenance window in the following ways:

Customizing the window and columns

• Resize the window and columns using standard Windows 95 contro

• Use the horizontal or vertical scroll bars to move around in the alarm
display.

• An ellipsis (...) after column text indicates there is more information th
will fit in the column. You can resize the column by dragging the colum
divider to make more room for text.

• A splitter bar divides the window into two display areas. Drag the split
bar to change the sizes of the card list and command results display a

Sorting the list
By default, items are listed in an order optimized for that application. You 
sort the list according to another column by clicking in that column headi
Click to sort in ascending order (an “up” arrow appears in the heading); c
again for descending order (“down” arrow). 

Note: For help on the definition of any column in the list, click 
What’s This  in the Help  menu, and then click the column title.

Using shortcuts
The application provides convenient keyboard equivalents for many menu 
selections. You can perform the following common tasks by typing the 
accelerator keys:

• <Ctrl>R (Status)—Displays detailed status information for the selecte
hardware device

• <Ctrl>T (Test)—Performs predefined tests on the selected hardware
device

• <Ctrl>W (Enable)—Restores the selected hardware device to service

• <Ctrl>D (Disable)—Removes the selected hardware device from serv
P0906946 Standard April 2000
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Using the Toolbar
The Toolbar gives you quick access to selected commands. Each button is 
documented in the on-line help (see Figure 4).

Using the Status Bar
To display or hide the Status Bar located at the bottom of the window, use the 
Status Bar command in the View menu. 

The Status Bar describes actions of the menu commands as you use the mouse 
to navigate through menus. When you select a Maintenance menu item, the 
status bar displays the following:

• The type of object selected

• The first overlay command in the script

When you run a Maintenance menu command, the Status Bar describes t
progress of the command while it executes. For example, the Status Ba
shows “Enable command in progress” when you choose an Enable 
command.

The Status Bar also displays the actions of the Toolbar buttons as you m
the pointer over them.

Figure 4
 CPU toolbar
MAT Maintenance Windows User Guide
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Printing
You can print Maintenance Windows information by selecting the lines to 
print in the list or the command results area (or the entire section), and 
selecting Print from the File menu. Select Print to File in the Print dialog to 
export the data for use in a spreadsheet or other application.

Supported Systems
Maintenance Windows is only supported on the MAT Release 5 and higher, 
and on Meridian 1 systems with X11 Release 22 or later and the MAT 
Management Interface package (296).

The following Meridian 1 systems are supported:

• Option 11C

• Option 51C

• Option 61C

• Option 81

• Option 81C

It also supports the Option 11C Compact beginning with X27 Release 1

Feature Limitations
• Not all hardware maintenance commands are supported. See the tab

each Maintenance Window application chapter for the list of suppor
hardware and commands.

• Only one user can access a maintenance overlay at a time (this is a
existing limitation of the overlays). Commands issued from a 
Maintenance window will be queued if:

— A TTY user has loaded a maintenance overlay.

— Another Maintenance window (same or different user) is running
script that uses the same maintenance overlay.

— Only one command can be issued from a Maintenance window 
time (that is, you must wait until the first command is completed
before issuing another).
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— One Pseudo TTY port is required for Maintenance Windows 
(regardless of the number of windows and logged-in users). Eac
instance of the System Terminal window (active or inactive) 
requires an additional Pseudo TTY port. This is in addition to th
PPP/ethernet ports required for the basic MAT PC connection.

— Maintenance window menus are not context sensitive to the 
maintenance state of the selected Meridian 1 object. For examp
the enable command will not be grayed out if the object is alrea
enabled. You will get the same response as entering the enable
command in the overlay (usually an error message stating that t
card is already enabled).
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Core CPU window
The Core CPU window displays the status of cards in the CPU shelves on the 
selected Meridian 1 system. 

Launching Core CPU
From the System window, under Core Equipment, double-click Core CPU 
icon—the Core CPU window appears as shown in Figure 5. 

Figure 5
CPU window
MAT Maintenance Windows User Guide



Page 28 of 76  Core CPU window
The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Core CPU column descriptions
The Core CPU window provides columns of information about each card 
installed in the shelf. The Core CPU list is initially sorted by CPU number 
(there may be one or two CPU shelves, depending on the hardware type). 
Table 1 describes each column. 

Table 1
Core CPU window column descriptions

Column Description

CPU Shelf number associated with the card

Card CPU card type; the following types are listed:

Core Processing Unit (CPU) cards

Core Multi-Disk Unit (CMDU) cards

Input/Output Processor (IOP) cards

Clock Controller (Clock) cards

Fiber cards (Option 11C only)

State A card can be in an active or standby state

Mode Mode applies only to CPU and CMDU cards:

CPU cards may be in split or shadowed mode. The faceplate 
may be in Normal or Maintenance mode.

CMDU cards may be in Redundancy enabled or Redundancy 
disabled mode.

Status Current status of the card. For a more detailed status report, 
use the Status command in the Maintenance menu.
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Supported Core CPU commands
Table 2 lists the hardware and commands supported. Use System Terminal 
for hardware or commands not supported by the Core CPU window. 

Table 2
Supported Core CPU Commands

Hardware Supported Commands supported

CP cards yes all, except split and shadow CPU 
commands

I/O Processor (IOP) cards yes all except disable IOP and Ethernet 
commands (User will lose 
connection to M1.)

Core Multi-Disk Units 
(CMDU)

yes all

Clock Controller yes all

Fiber Optical Link 
(Option 11C)

yes all, includes cabinet enable/disable 
commands
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I/O Ports window
The I/O (Input/Output) Ports window displays the status of all I/O ports on 
the Meridian 1. 

Launching I/O Ports
From the System window, under Core Equipment, double-click the I/O 
Ports icon. The I/O Ports window appears as shown in Figure 6.

The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Figure 6
I/O Ports window 
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I/O Ports column definitions
The I/O Ports window provides columns of information about each port in the 
system. The I/O Ports list is initially sorted by port type and number. Table 3 
describes each column. 

Table 3
Column descriptions  (Part 1 of 3)

Column 
Name

Description

Type Type and number of I/O port:

— Teletype (TTY)
— Printer (PRT)
— Application Module Link (AML)
— D-Channels
— Intercept Computer Update Link (ICP)
— Ethernet Local Area Network (ELAN)
— Single Terminal Access (STA)
— D-channel Digital Signaling Link (DDSL)
— Low Speed Signaling Link (LSSL)

Device Physical address of the card or port.
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Designation Port name. 

Card Type Card containing the I/O port:

— Serial Data Interface Card (SDI)

— Enhanced Serial Data Interface Card (ESDI)

— D-channel Interface Card (DCHI)

— Multi-purpose Serial Data Link Card (MSDL)

Port Port number on the card.

Device 
Status

Current maintenance status of the port.

Card Status Current maintenance status of the card. Applies only to MSDL
Cards.

Table 3
Column descriptions  (Part 2 of 3)

Column 
Name

Description
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User Type Indicates current port usage.

— ACD: Automatic Call Distribution printer
— APL: Auxiliary Processor Link
— ICP: Intercept Computer Update Link
— LSL: Low-speed AUX link
— HSL: High-speed AUX link
— XSM: System monitor
— BGD: Background terminal
— CTY: Call Detail Recording (CDR) TTY for CDR records
— PMS: Property Management System Interface (PMS)
— BUG: BUG messages included on port
— CSC: Automatic Set Relocation and Attendant 

Administration messages (CSC) included on port
— FIL: Output filtered messages included on port
— MCT: Malicious Call Trace messages included on port 
— MTC: AUD, BUG, and ERR messages included on port
— NOO: No overlay allowed on port
— SCH: Service Change or any database change included on

port
— TRF: Traffic reports included on port

Table 3
Column descriptions  (Part 3 of 3)

Column 
Name

Description
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Supported I/O Ports commands
Table 4 lists the supported I/O Ports hardware and commands. Use System 
Terminal for hardware or commands not supported by the I/O Ports window. 

Table 4
Supported I/O Ports Commands  (Part 1 of 2)

Hardware Supported Commands supported

TTY port on SDI/MSDL card yes all except test command

XSM (System Monitor) on 
SDI/MSDL card

yes all

PRT - Printer port on SDI/MSDL 
card

yes all except test command

PTY - Pseudo TTY port yes all

AML - (Application Module 
Link) on an ESDI/MSDL card

yes all except message monitor 
commands

ACD High Speed Port on 
SDI/MSDL card

yes all except message monitor 
commands
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ACD Low Speed Port on SDI 
card

yes all except message monitor 
commands

Auxiliary Processor Links on any 
SDI/MSDL card

yes all except message monitor 
commands

Intercept Computer Update ports 
(ICP) on any SDI/MSDL card

yes all except ICP application 
commands

D-channel on an MSDL/DCHI 
card

yes all except message monitor 
commands

Single Terminal Access port yes all

MSDL card yes all except download version 
x of software

ACD Low Speed Link for Option 
11C

yes all

ICCM ELAN for ICCM yes all

DPNSS DDSL (D-channel) yes all

APNSS LSSL (D-channel) yes all

Table 4
Supported I/O Ports Commands  (Part 2 of 2)

Hardware Supported Commands supported
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Network Groups window
The Network Groups window displays the status of all Network Group cards 
on the Meridian 1. 

Launching Network Groups
From the System window, under Core Equipment, double-click the Network 
Groups icon. The Network Groups window appears as shown in Figure 7.

The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Figure 7
Network Groups window 
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Network Groups column definitions
The Network Groups window provides columns of information about each 
port in the system. The Network Groups list is initially sorted by Group 
number. Table 5 describes each column. 

Table 5
Column Descriptions

Column 
Name

Description

Group Network group identification number.

Card Type Each network group can include the following cards:

— Core to Network Interface cards (2 cards)

— Peripheral Signaling cards (2 cards)

— InterGroup Switch cards (4 cards)

ID Card identification number. ID for CNI cards include the CPU 
number, slot number, and the port number.

Status Current status of the card. For a more detailed status report, u
the Status command on the Maintenance menu.
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Supported Network Groups commands
Table 6 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the Network Groups application.

Table 6
Supported Network Groups commands

Hardware Supported Commands supported

Core to Network Interface (CNI) 
card

yes all

Peripheral Signalling card yes all

InterGroup Switch card yes all
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Network Loops window
The Network Loops window lists all the network loops on the Meridian 1 
system. 

Launching Network Loops
From the System window, under Core Equipment, double-click the Network 
Loops icon. The Network Loops window appears as shown in Figure 8.

Figure 8
Network Loops window 
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The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Network Loops column descriptions
The Network Loops window provides columns of information about each 
loop in the system. The Network Loops list is initially sorted by Loop 
number. Table 7 describes each column. 

Table 7
Network Loops window column descriptions

Column Description

Loop Loop number.*

Type Type of Loop

Status Current status of the card. For a more detailed status 
report, use the Status command in the Maintenance 
menu.

Additional 
Information

Applies only to PRI/PRI2 and International RPE loops:

• For PRI/PRI2 loops, displays the application status,
link status, and designation for the Primary and 
Backup D-channels (DCH).

• For 2.0 mb/s RPE loops, displays the RPE group 
number. 

Note: *Loop is replaced by slot for Option 11C.
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Supported Network Loop commands
Table 8 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the Network Loops window. 

Table 8
Network Loops  (Part 1 of 2)

Hardware Supported Commands supported

Enhanced PE (EPE) Network 
Loop card

yes all except test timeslot and 
LD45 XCON commands

Superloop cards yes all except LD 45 XCON 
commands and 
enable/disable background 
continuity tests.

Digital Trunk Interface 
(DTI/DTI2) cards

yes all

Primary Rate Interface 
(PRI/PRI2) cards

yes all
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Remote Peripheral Equipment 
(1.5 and 2.0 Mb/s) cards

yes all

Meridian ISDN Signaling 
Processor (MISP) cards

yes all except application 
download commands and 
Meridian Packet Handler 
commands

DPNSS/DASS2 cards yes all

APNSS cards yes all

Conference cards yes all

Tone and Digit Switch cards yes all

Conf/TDS cards yes all

Fiber Remote (FNET) card yes all

Multifrequency Sender cards yes all

Phantom loops yes None. There are no overlay 
commands for these loops. 
Phantom loops do appear in 
the list of loops.

Table 8
Network Loops  (Part 2 of 2)

Hardware Supported Commands supported
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PE Shelves window
The PE Shelves window displays the status of the Peripheral Controller Cards 
for each PE Shelf on the Meridian 1. 

Launching PE Shelves
From the System window, under Core Equipment, double-click the PE 
Shelves icon. The PE Shelves window appears as shown in Figure 9.

The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Figure 9
PE Shelves window 
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PE Shelves column definitions
The PE Shelves window provides columns of information about each shelf in 
the system. The PE Shelves list is initially sorted by Controller card number. 
Table 9 describes each column. 

Supported PE Shelves commands
Table 10 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the PE Shelves window.

Table 9
Column Descriptions

Column Name Description

PE Controller Identification number associated with the PE 
Controller Card.

Type Type of controller card.

Location Location of the PE shelf containing the PE Controller 
Card.

Status Current status of the PE Controller Card.

Seg 0 to Seg 3 Identifies the loop supported by each of the four PE 
shelf segments.

Table 10
Supported PE Shelves commands

Hardware Supported Commands supported

Peripheral Controller (XPEC) 
cards

yes all

Fiber Remote (CARR) yes all

Fiber Remote (FPEC) yes all
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PE Cards window
The PE Cards window displays the status of the all Peripheral Equipment 
Cards for each PE Shelf on the Meridian 1. 

Note: The MGate card cannot be configured through MAT. It can be 
manually configured in Overlay 11.

Launching PE Cards
From the System window, under Core Equipment, double-click the PE 
Cards icon. The PE Cards window appears as shown in Figure 10.

The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Figure 10
PE Cards window 
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PE Cards column definitions
The PE Cards window provides columns of information about each card in 
the system. The PE Cards list is initially sorted by TN. Table 11 describes 
each column.

Table 11
Column Descriptions

Column Name Description

Terminal Number 
(loop shelf card)

Address of the card.

Note: TN is replaced with Slot for Option 11C. Tone Service in slot 0 is for DTR/XTD 
units 0-7, and DTR/XTD/MFC or MFR units 8-15. The individual units are displayed in the 
PE Units window.

Card Type The internal value and type of the various loops, as well as 
the name presented to the user. There are two types of line 
and trunks, one for EPE loops and one for Superloops. 
Superloops have density of octal.

Card Density Density of the card (this can differ from loop density). 

— Single

— Double

— Quad

— Octal

Status Current status of the PE Card. The status is a text string 
up to 10 characters. This is the same text as output by 
the overlays.
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Supported PE Cards commands
Table 12 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the PE Cards window. 

Table 12
Supported PE Cards commands

Hardware Supported
Commands 
supported

IPE/EPE Line cards yes all

ISDLC cards yes all

IPE/EPE Trunk cards yes all

BRI Line cards yes all

BRI Signaling Processor (BRSC) cards yes all

Digitone Receivers (DTR) yes all

Multifrequency Receivers (DTR) yes all

Tone Detector cards yes all

Extended Tone Detector (XTD) cards yes all

Multifrequency Signaling 
(MFC/MFE/MFVE/MFK5/MFK6) cards

yes all

Mobility

— EIMC

— MXC

Note: These cards appear in the list of cards. 
However, all maintenance commands for 
them can only be accessed using the 
Mobility application.

yes

yes

none

none
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PE Units window
The PE Units window displays information for selected PE units and 
Directory Numbers on the Meridian 1 system.

Launching PE Units
From the System window, under Core Equipment, double-click the PE Units 
icon. The Find PE Units dialog box (Figure 11) appears to allow you to select 
a range of DNs or TNs. This helps you avoid uploading thousands of items. 

Figure 11
Find PE Units dialog
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You can view both TNs and DNs in the PE Units window.

— Viewing by TN is more useful than print TNB

— Viewing by DN is more useful than print DNB

Make a selection of DN or TN, select a range, and click OK. The PE Units 
window appears as shown in Figure 12 or Figure 13 (depending on whe
you selected TN or DN in the Find dialog box).  

Figure 12
PE Units window (by TN)
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The command results area in the lower portion of the window displays the 
results of Maintenance menu commands.

Figure 13
PE Units window (by DN)
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PE Units column definitions
The PE Units window provides columns of information about each DN and 
TN in the system. The PE Units window is initially sorted by DN or TN 
number (depending on what you specified in the Find PE Units dialog box). 
Table 13 describes each column. 

Table 13
Column definitions

Column Name Description

TN Terminal number address associated with the card. This 
address includes the loop, shelf, card, and unit number for 
all systems except Option 11. For Option 11 this address 
includes card and unit.

DN Directory number.

Type Type of PE unit.

Status Current status of the PE unit. For a more detailed status 
report, use the Status command on the Maintenance menu.

Designation Additional information about the unit, such as location or 
cabling details, specified by the person who installed the 
unit.

Prime DN Directory number (DN) associated with key 0 on the 
telephone.

DN Name Name associated with the directory number.

Customer Customer number associated with the PE unit.

Date Last date data was updated for this unit.

NCOS Network Class of Service group associated with the unit.

Key Telephone key number associated with the directory number 
(DN).

MARP Indicates whether this telephone is the Multiple Appearance 
Redirection Prime (MARP).
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Supported PE Units commands
Table 14 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the PE Units window. 

Table 14
Supported PE Units commands

Hardware Supported Commands supported

500 - 500/2500 telephone yes all

1250 - M1250 Console yes all

2003 - 2003 telephone yes all

2006 - M2006 telephone yes all

i2004 - M2004 Internet 
telephone (ITG)

yes all

2008 - M2008 telephone yes all

2009 - M2009 telephone yes all

2016 - M2016 telephone yes all

2018 - M2018 telephone yes all

2112 - M2112 telephone yes all

2216 - M2216 telephone (ACD) yes all

2250 - M2250 Console yes all

2317 - M2317 telephone yes all

2616 - M2616 telephone yes all

3000 - M3000 Touchphone yes all

ADM - Add-on Data Module yes all

AID - AIOD trunk yes all

Note: The manual test command is not supported for any trunk type. Option 11C Model 
TNs are not supported.
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ATT - QCW3/4 Console yes all

ATVN - Autovon trunk yes all

AWR - Automatic Wake-Up 
RAN/Music trunk 

yes all

CMOD - Class Modem yes all

BRI - Basic Rate Interface yes all

COT - Central Office Trunk yes all

CSA - CCSA trunk yes all

DIC - Dictation trunk yes all

DCE - Digital Cordless Set yes all

DID - DID trunk yes all

DTD - Dial Tone Detector yes all

DTR - Digitone Receiver yes all

FEX - Foreign Exchange trunk yes all

FGDT - Feature Group D Trunk yes all

IDA - Integrated Digital Access yes all

ISA - Integrated Services Access 
trunk (ISDN)

yes all

ITG - Integrated IP Telephony 
Gateway

yes all

MCU - Communications Unit yes all

MDM - Modem/Data Module. D yes all

Table 14
Supported PE Units commands (Continued)

Hardware Supported Commands supported

Note: The manual test command is not supported for any trunk type. Option 11C Model 
TNs are not supported.
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MFC - Multifrequency Signaling yes all

MFE - Multifrequency Signaling 
for Socotel sender/receiver

yes all

MFK5/MFK6 - Spanish KD3 
MF Signaling

yes all

MFR - Multifrequency Receiver 
(FGD)

yes all

MFVE - Multifrequency 
versatile units

yes all

MUS - Music trunk yes all

OOSS - Out of Service Terminal yes all

PAG - Paging trunk yes all

PWR - Power yes all

R232 - Data Access unit yes all

R422 - Data Access unit yes all

RAC - Real Analog Channel yes all

RAN - Recorded Announcement 
trunk

yes all

RCD - Recorder trunk yes all

RDC - Real Digital Channel yes all

RLM - Release Link Main trunk yes all

Table 14
Supported PE Units commands (Continued)

Hardware Supported Commands supported

Note: The manual test command is not supported for any trunk type. Option 11C Model 
TNs are not supported.
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Mobility

—MPORTBL

Note: This card appears in the list 
of cards. However, all 
maintenance commands for 
this card can only be 
accessed using the Mobility 
application.

yes none

RLR - Release Link Remote 
trunk

yes all

SL1 sets yes all

TCON - Tandem Connection for 
MPH 

no none

TDET - Tone Detector yes all

TIE - TIE trunk yes all

VAC - Virtual Analog Channel yes all

VDC - Virtual Digital Channel yes all

WAT - Wide Area Telephone 
Service trunk

yes all

XTD - Extended Dial Tone 
Detector and Digitone Receiver

yes all

DN types: ACDN, ADCP, CDN, 
CDP, CHDN, DISA, DSDN, 
FCC, LDN, MCDN, NARS, 
PARK, RDB, REFx, RLDN, 
RSA, SFP, SS25, T100, TSTx, 
VNS, IADN

yes These are DNs which have 
no associated TN. 
Typically, the only 
command is print DN 
block.

Table 14
Supported PE Units commands (Continued)

Hardware Supported Commands supported

Note: The manual test command is not supported for any trunk type. Option 11C Model 
TNs are not supported.
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B- and D-channels window
The B and D-channels window displays the channels on the selected digital 
trunk. It allows you to execute overlay commands for a selected channel by 
choosing commands from the Maintenance menu. The results appear in the 
Command Results area of the window. The Cancel button allows you to 
terminate a command in progress.

The following types of channels appear in the B and D-channels window:

• B-channel on a PRI/PRI2/DTI/DTI2/DPNSS loop

• D-channel on DCHI Card

• D-channel on MSDL Card

• Real Analog Channel (RAC)

• Real Digital Channel (RDC)

• Virtual Analog Channel (VAC)

• Virtual Digital Channel (VDC)

Launching B- and D-channels
From the System window, under Core Equipment, double-click the Network 
Loops icon. Select a PRI/PRI2 loop. From the Maintenance menu or the 
right mouse popup menu, select Channels. The B and D-channels window 
appears (see Figure 14).

The command results area in the lower portion of the window displays th
results of Maintenance menu commands.
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B- and D-channels column definitions
The B and D-channels window provides columns of information about each 
loop in the system. The B and D-channels list is initially sorted by Channel 
number. Table 15 describes each column. 

Figure 14
Channels window

Table 15
Column definitions

Column Name Description

Channel Number Number associated with the channel. PRI loops may have 
0-23 channels; PRI2 loops from 0-29 channels.

Type Type of channel.

Status Current status of the channel.
P0906946 Standard April 2000



 B- and D-channels window Page 61 of 76
Supported B- and D-channel commands
Table 16 lists the supported hardware and commands. Use System Terminal 
for hardware or commands not supported by the B and D-channels window. 

Table 16
B and D-channels

Hardware Supported Commands supported

The window contains the list of 
channels for the selected loop. 
D-channels can also be accessed 
from the I/O ports window. 
DPNSS loops have both real and 
channels

yes all, except enable all channels 
on DTI cards and loopback 
test commands.
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Inventory Reporting
The MAT Inventory Reporting application allows you to generate system 
inventory files and download them to your PC. The inventory files list cards 
and sets installed in your system.

Note: Inventory Reporting requires that you have Maintenance Windows 
and Microsoft Excel 95 or later installed. You also need an Ethernet 
connection to your Meridian 1 switch.

Inventory Reporting is based on Overlay 117. For additional overlay 
information, see the Meridian 1 X11 input/output guide.
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Launch Inventory Reporting
1 In your MAT Navigator window, open a System Window for the Meridian 1 

system you wish to inventory. (See Figure 15.) Connect to that system. (See 
the Common Services User Guide for procedures.) 

Note: If you do not connect to a system before opening Inventory Reporting, 
some features are disabled.

Figure 15
Sample system window

2 Once connected, double-click the System Window Inventory icon.

Note: If you have not connected to a system, a dialog box will appear asking 
if you want to connect. Click Yes to connect to a system, or click No to 
proceed without connecting.

The Inventory window (Figure 16) appears.
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Figure 16
Inventory window

The main Inventory window contains the PC Files frame and the System Files 
frame. The PC Files frame lists inventory files downloaded from the 
Meridian 1 system. The System Files frame provides status and statistics for 
the Meridian 1 system.
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Main window menus
Inventory Reporting’s main window menus include the following comman

• File

— Open: Open the file selected in the list view of the PC File fram

— Delete: Delete the file selected in the list view of the PC File 
frame.

— Exit: Exit the Inventory window.

• View

— Toolbar: Toggle the Inventory toolbar.

— Status Bar: Toggle the status bar.

— Automatic Status: If selected, Inventory Reporting updates th
inventory file status displayed on the System File frame every
seconds.

• Inventory

— Abort...: Abort any file generation now running on the system

— Download...: Download one or more inventory files from the 
system.

— Generate...: Generate one or more inventory files.

— Status: Query the inventory status of the system.

• Help

— Help Topic: Provide a list of help topics.

— What’s This? : Change the cursor and display help information 
about the next item you select.

— About Inventory...: Provide Inventory Reporting application 
release information.
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Inventory files
The PC Files frame lists all inventory files downloaded from the Meridian 1 
system. There are two types of inventory files available:

• Card Inventory files

• Set Inventory files

To open a file, select it from the list, then go to menu File - Open. Inventory 
Reporting creates a temporary report file (*.CSV) which opens in Micros
Excel.

To delete a file from the list, select it and then go to menu File - Delete.

Card Inventory files
The Card Inventory file provides columns of information in Excel about ea
card configured in the system. Table 17 describes each column.

Figure 17
Sample Card Inventory file
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The following card types are included in the Card Inventory file:

• All IPE and common equipment cards

• All Meridian 1 cards that have a Hardware ID (a.k.a. ID PROM)

The following card types are not included in the Card Inventory file:

• Cards manufactured without an ID PROM

• TTY or PC cards

• Power Supply

• Any non-Nortel (third-party) cards, including those designed to simula
included cards.

Table 17
Card Inventory file column descriptions

Column name Description

TYPE Card type

TN Terminal number address associated with the card.

ID PROM 32 byte ASCII string whose characters (in order) 
represent:
Product Engineering Code (PEC)
Color (numeric representation)
Release
One blank character
Product Serialization ID
One blank character
Other (free field)
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Set Inventory files
The Set Inventory file provides columns of information in Excel about each 
set configured in the system. Table 18 describes each column.

Figure 18
Sample Set Inventory file
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The following sets are included in the Set Inventory file:

Table 18
Set Inventory file column descriptions

Column name Description

TYPE Set type

TN Terminal number address associated with the set.

ID Prom 32 byte ASCII string whose characters (in order) 
represent:
Product Engineering Code (PEC)
Color (numeric representation)
Release
One blank character
Product Serialization ID
One blank character
Other (free field)

DESignator 6 character ASCII string used by Station 
Administration and Overlay 11.

Primary DN Primary directory number

M2006 M2008

M2016 M2616

M2216 M390X

M3110 M3310

M3820
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te 
The following sets (and data units) are not included in the Set Inventory file:

• SL-1 sets and data units

• 500/2500 sets and data units

• Any other digital sets or data units

• Any non-Nortel (third-party) sets, including those designed to simula
included sets.

• Data units on: M2006 M2008

M2016 M2616

M2216 M390X

M3110 M3310

M3820
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Generate an inventory file
You will need System Administrator privileges to generate an inventory file.

To generate the file:

1 In the Inventory window, select Inventory - Generate...

A dialog box appears.

Figure 19
Select file to generate

2 Check Card File to generate the Card Inventory file.

3 Check Set File to generate the Set Inventory file.

Note: If both boxes are checked, both files will be generated.

4 Click OK to begin generating the file(s).
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Download an inventory file
You will need System Administrator privileges to download an inventory 
file.

To download the file:

1 In the Inventory window, select Inventory - Download...

A dialog box appears.

Figure 20
Select file to download

2 Check Card File to download the Card Inventory file.

3 Check Set File to download the Set Inventory file.

Note: If both boxes are checked, both files will be downloaded.

4 Click OK to begin downloading the file(s).
MAT Maintenance Windows User Guide
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Check file generation status
To check file status:

1 In the Inventory window, select Inventory - Status.

The System Files frame information is updated. Set and Card Inventory status 
consists of a state value and a substate value. See Table 19 and Table 20 for 
their interpretations.  

Table 19
Valid state values

State value Meaning

IDLE There is no activity on the switch 
involving the inventory files.

BUSY An inventory file is in use.

Table 20
Valid substate values

Substate value Meaning

NONE There is no activity on the switch 
involving the inventory files.

GENERATING An inventory file is being generated 
by the switch software.

DOWNLOADING An inventory file is being 
downloaded from the switch to the 
PC.
P0906946 Standard April 2000



 Inventory Reporting Page 75 of 76
Abort file generation
You will need System Administrator privileges to abort generation of an 
inventory file.

To abort generation:

1 In the Inventory window, select Inventory - Abort

A dialog box appears.

Figure 21
Select file to abort

2 Check Card File to abort generation of the Card Inventory file.

3 Check Set File to abort generation of the Set Inventory file.

Note: If both boxes are checked, both files will be aborted.

4 Click OK to abort generation of the file(s).
MAT Maintenance Windows User Guide
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